
• To return to the booking process, tab to LSN or LSPS.

• Enter LS to return to your current location. You can enter LSPI anytime 
during the booking process.

• When you have made your choice enter the line number of your selected 
vacation at the LSN prompt. e.g. LSN[4].

PACKAGE INFORMATION         UNI   UNIVERSAL VACATIONS                              

ONSITE AIR/HOTEL VACATION                        250-370                           

3NTS                                                                 

INCL:ACCOM AIR                                                                                      SS     

1  DATE DEPARTURE DATES                  3  NARR PACKAGE NARRATIVE           

4  COMM COMMISSION INFORMATION   5  FEOP FEATURES/OPTIONS              

6  TERM TERMS AND CONDITIONS         9  SPEC SPECIAL PRICING                  

10  CANC CANCEL/CHANGE POLICY      13  PROP PROPERTIES FEATURED       

15  ADVC CONSUMER ADVICE           

ENTER NO OR KEYWORD TO DISPLAY                                                 

SELECT >LSPI-      CHECK AVAIL >LSN2      RETURN TO PKG SELECT >LSPS     

>   

PACKAGE SELECTION        UNI UNIVERSAL VACATIONS     USD               

>LSS/07MAR-05JUN/D:MCO-MCO/M:USD/O:ATL/V:UNI                                   

19 PACKAGES RETURNED:                                                          

1  ONSITE AIR/HOTEL VACATION          SS ID:MCOUNZZZDLUA                     

INCL:ACCOM AIR                                         2-30NTS                270               

2  ORLANDO AREA HOTEL VACATION  SS ID:MCOUNZZZUAFA                     

INCL:ACCOM AIR                                         2-30NTS                300               

3  NON-FLA ONSITE AIR/HOTEL            SS ID:MCOZZZUANA                     

INCL:ACCOM AIR                                         2-30NTS                245               

4  ONSITE AIR/HOTEL VACATION SS ID:MCOUNZZZUAUA                     

INCL:ACCOM AIR                                         2-30NTS                270               

SELECT LINE NBR FOR CHOICES OR PKG INFO  SELECT PKG >LSN                  

>LS*PD                       PACKAGE INFO >LSPI                      DETAIL >LSD

SEARCH                           LEISURESHOPPER                             HELP            

>LSS*                                                                          

DESTINATION/S      : ........................................................... / .......                        

: ........................................................... / ........                        

DEP DATE/RANGE  :   07MAR-   05JUN                                                

PRICE OR RANGE  : ..................................- ..........................  CURR: USD      

BASED ON PER PERSON  -  DOUBLE OCCUPANCY                        

LENGTH/S OF STAY: ... OR  ...                                                 

DEPARTURE CITY   : ATL                                                        

ACTIVITY/S              : ..............................[ ..........................                            

PACKAGE TYPE/S   : ...............................[ ..........................                            

VENDOR                  : UNI                                                        

DESTINATION IS THE MINIMUM REQUIRED ENTRY

>   

• Enter LSS/V:UNI for Universal Parks & Resorts Vacations. The Search screen will 
display. Fill in the Destination, Departure Date (defaults to 90 day range, type 
over dates to extend date range), Length of Stay, and Departure City fields. If 
searching for land only package, enter LND in the PACKAGE TYPE/S field. 

• You can access the AVAILABILITY screen directly if you know the correct vacation 
identifier code. Enter LSA/V:UNI then fill in origin city, date, vacation identifier, 
length of stay, number in party, and type of room on availability screen (the 
vacation identifier space is located after the vendor code on the third line).

1. Search

• On the PACKAGE SELECTION screen, use the LS*PD and LS*PU to view the all 
of the vacations options. At the LSPI prompt, enter the line number of the 
vacation you want to view details about. e.g. LSPI[5]. On the Package 
Information screen, type the line number of the item of your choice after the 
LSPI prompt (e.g. LSPI[9] special pricing to see information about current specials).
NARR: classes of service
TERM: payment information
FEOP: package inclusions
SPEC: specials

2. Selecting a Vacation
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• For codes to the left:
For example, MCOUNZZZUAUA.
MCO: Orlando (airport code)
UN: Universal Parks & Resorts Vacations
ZZZ: Includes airline tickets
XXX: Land only package
DL: Delta Airlines is the carrier     UA: United Airlines is the carrier
US: US Airways is the carrier       CO: Continental Airlines is the carrier
UA: Last two letters are package identifiers



• To view the hotel description (including hotel policies) enter the line number of 
the accommodations that you have chosen at the LSD prompt. (e.g. LSD[3]).

• DO NOT QUOTE THE PRICE in the price column as it will list the approx. 
total price for only the adult occupants.

OPTIONS MENU                                                                  

UNIVERSAL VACATIONS                       ONSITE AIR/HOTEL VACATION                

STOP 00   DL FLT                                                    21MAR-3   NTS                

1   ALAMO CAR RENTALS                                           

2   2 DAY 2 PARK 3RD DAY FREE

3   2 NT LENGTH OF STAY PASS 

4   3 NT LENGTH OF STAY PASS QTY  -   3

5   4  NT LENGTH OF STAY PASS

6   4 PARK ORLANDO FLEXTICKET

SELECT OPTION NUMBER OR 0 TO CONTINUE                                          

SELECT OPTION >LSN                                           

>   

UNIT SELECTION                                                                                   USD        

UNIVERSAL VACATIONS                         ONSITE AIR/HOTEL VACATION              

DL FLT          HARD ROCK HOTEL                                    21MAR-3NTS                

TRIPLE            SELECT 1                                                            

UNIT TYPE           BEDS           NUM AVAIL ADJ TO ACCOM BASE                  

1   GARDEN VIEW                          1                    0                 

2   POOL VIEW                               8              20 

3   DELUXE ROOM                         4 80

4   HARD ROCK CLUB                    1                                             100

SELECT FORMAT IS LINE NUMBER   /   QUANTITY OF UNITS                              

SELECT UNIT >LSN                  UNIT DESC >LSD         

>   

ACCOMMODATION SELECTION                                                        USD             

UNIVERSAL VACATIONS                        NONSTOP 3NT AIR/HOTEL CHARTER    

STOP 00   DL FLT                                                      21MAR-3NTS                       

PER PERSON DBL OCC      LOW TO HIGH       EXCEPTION OK MANDATORY      

1 HARD ROCK HOTEL 230

2 PORTOFINO BAY HOTEL 240 

SELECT ACCOMMODATION LINE NUMBER                                               

>LS*PD              ACCOM >LSN        ACCOM DESC >LSD     VIEW >LSVM             

>   

TRANSPORTATION SELECTION                                                               USD      

UNIVERSAL VACATIONS                          NONSTOP 3NT AIR/HOTEL CHARTER  

FLIGHTS                                                                      LOW TO HIGH                   

1 DL  141 C               ATL    MCO   700A 847A               0            0  21MAR            

DL  140 Y               MCO  ATL     630P1153P              0            0  24MAR            

2 DL   23 C                ATL    MCO   730A 900A               0            0  21MAR            

DL   24 Y                MCO  ATL     600P1115P              0            0  24MAR            

SELECT TRANSPORTATION AND CLASS OF SERVICE                                     

SEL TRANS >LSN      PRICE >LSTP       MENU >LSTM           

>   

AVAILABILITY                            LEISURESHOPPER                  -HELP             

>LSA*                                                                          

DATE                                        *: ..... DEP TIME: .... RET TIME: ....               

VENDOR/IDENTIFIER                *: UNI/MCOUNZZZDLUA.. PRICE CAT: ...     

LENGTH OF STAY                     *: 003                                                 

NUMBER IN PARTY                   *: 1                                                   

NUMBER OF ROOMS/CABINS   *SGL: . DBL: . TPL: . QUAD: . OTH: .                 

AGES                                         : ..  ..  ..  ..  ..  ..  ..  ..  ..                  

DEPARTURE CITY                     : ATL.. RETURN FROM CITY  : .....              

VENDOR AIR  Y OR N                : .         RETURN TO CITY    : .....                

STOPOVER    Y OR N                : .         GATEWAY: .....  

ACCOMMODATION EXCEPTION  Y OR N: .                                            

MINIMUM REQUIRED IS ALL FIELDS WITH *             

>

• The Departure date, vacation identifier and vendor information will automatically
populate the AVAILABILITLY screen based on the information from the SEARCH 
screen. (You can still modify the information on this screen). 

• Enter length of stay, number in party, type of room in appropriate fields. 
(Only 1 room per booking is allowed.) Enter ages of Children (If children are 
traveling, you need to enter each child’s age in the Age fields). 

• If entering departure or return times, these must be entered in military time 
(e.g. 1300).

3. Availability

• On the TRANSPORTATION SELECTION screen, only those flights and classes of  
service that are available will display. If only one flight and class of service is 
available, it will automatically be selected for you. 

• Enter the line number of the desired flight and class of service at the 
SELTRANS prompt. 

4. Transportation Selection

• Only those properties available for the requested dates will display, at the LSN 
prompt, enter the line number of the accommodation of your choice (e.g. LSN [3]).
If a property has more than one room category available a UNIT SELECTION 
screen will appear. At the LSN prompt enter the line number of the room 
category you prefer. 

5. Accommodations Selection

• Enter the line number of the desired option group at the LSN prompt (e.g. LSN[1])
or if no option group is needed, enter zero to continue (e.g. LSN[O]).

6. Option Menu

Information on the print screens is for demonstration purposes only.
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PRICING/PAYMENT INFORMATION                                                    

UNIVERSAL VACATIONS                     ONSITE AIR/HOTEL VACATION                  

PRICE: BASE:                        1305.45       OPTIONS :                            108.00      

TOTAL: USD                          1485.85               USD                            1485.85      

TAX1:                            18.00        P. ADULT:                            599.95      

TAX2:                              0.00         P. CHILD:                            285.95      

TAX3:                            54.40                                                  

PENALTIES:                              0.00                                                  

DPST:                     150.00 DUE 07MAR   BAL:                   1485.85 DUE 09MAR    

PAYMENT TYPES:   BA     CA    DS    AX                                             

SELECT PAYMENT TYPE                                                            

BOOK >LSFP                                                                     

>   

ITINERARY                      LEISURESHOPPER                                          

1 UNIVERSAL VACATIONS                    MCOUNZZZDLUA     21MAR-24MAR        

2 ONSITE AIR/HOTEL VACATION          STATUS: SS 3                                

3 21MAR AIR DL  141 -ATLMCO          700A  847A           0      C                3         

4 21MAR STP  0   DL FLT                               3 NTS                                     

5 21MAR ACC HARD ROCK HOTEL                3 NTS                                     

6 21MAR UNT GARDEN VIEW ROOM                                                             1T   

7 21MAR FEA DOC DELIVERY    EXPRESS FEE                               11     1 

8 21MAR FEA WAIVERS/INSURE  PRE TVL PEN WAI                        57    1 

9 21MAR OPT CAR RENTAL      ALAMO COMPACT 4                         72    1         

PU 21MAR  847A MCOA  DO 24MAR  630P MCOA       

10 24MAR AIR DL  140 -MCOATL      630P 1153P         0                  Y           3       

PRICE >LSPR                                                                    

DESC >LSD     VIEW >LSVM     CHG >LSC     CANC >LSX                  

>   

FEATURES/OPTIONS DETAILS                                                       

>LSFO*                                                                          * OPTIONS *                    

UNIVERSAL VACATIONS                     ONSITE AIR/HOTEL VACATION                  

STOP 00   DL FLT                                                       21MAR-3   NTS                

CAR RENTAL                   ALAMO COMPACT 4 DR     C4                                 

PICKUP       DATE:  21MAR     LOCATION:  MCOA.     TIME:  0847                    

DROPOFF   DATE:  24MAR     LOCATION:  MCOS.     TIME:  1830                    

END

FILL IN INFORMATION                                                           DESC >LSD    

DATE/TIME ASSUMED FROM PKG FLIGHT INFO - OVERTYPE TO CHANGE         

>   

OPTIONS                                                                        

UNIVERSAL VACATIONS                           ONSITE AIR/HOTEL VACATION            

STOP 00   DL FLT                                                         21MAR-3   NTS                

CAR RENTAL                    MAX AVAIL 01       RATE:PER ITEM                              

1  ALAMO ECONOMY 2 DR      EC               54                               

2  ALAMO ECONOMY 4 DR      E4                60                               

3  ALAMO COMPACT  2 DR      CC               66                               

4  ALAMO COMPACT  4 DR      C4                72                               

5  ALAMO INTERMED 2 DR      IC                 74                               

6  ALAMO INTERMED 4 DR      I4                 80                               

7  ALAMO STANDARD 2 DR     SC                82                               

SELECT FORMAT IS OPTION / QUANTITY WANTED                                      

>LS*PD                SELECT OPT >LSN           DESC >LSD         MENU >LSOM        

>   

OPTIONS                                                                        

UNIVERSAL VACATIONS                      ONSITE AIR/HOTEL VACATION                 

ORLANDO           HARD ROCK HOTEL                       21MAR-3   NTS                

TRANSFERS                      MAX AVAIL 09     RATE:PER ITEM                              

1  R/T TRANSFERS-MEARS                                        10                               

SELECT FORMAT IS OPTION / QUANTITY WANTED                                      

SELECT OPT >LSN        DESC >LSD      MENU >LSOM         

>   

• Enter the line number of the desired option group and the number needed at 
the LSN prompt (e.g. LSN[2/3]) or if no option group is needed, enter 
zero to continue (e.g. LSN[O]).

7. Option Selection

• For a detailed description of any option, enter the item number at the LSD 
prompt (e.g. LSN[5]).

• On the FEATURES/UPGRADES screen those items that you are required to 
select or decline will appear.  At the LSN prompt, enter the line number of 
your choice.

8. Features/Upgrades

• Enter the form of payment (e.g. LSFP[AGC]) at the LSFP prompt.  
AGC=Agency Check; MCO=Miscellaneous Charge Order; BA=Visa; 
CA=MasterCard; DS=Discover; AX=American Express.
- This form of payment entry does not have to be an actual form of payment. It is not 

interpreted as a payment, or payment guarantee. See "Adding Payment" section 
for instructions on how to add payment.

- Taxes are split into three amounts: TAX I is for PFCs, TAX2 is for state, country, 
and regional taxes, and TAX3 is for excise and hotel taxes.

- See the last page for information on revisions prior to confirmation.

10. Pricing/Payment

• To price the itinerary, Press Enter at the LSPR prompt.

• (To view any detailed descriptions on any item in the Itinerary (e.g. Car 
rental, Multi-day Park tickets etc.) tab to LSD enter the line number of 
the item you wish to view.)

9. Itinerary
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VENDOR CONFIRMATION                 LEISURESHOPPER                                      

UNIVERSAL VACATIONS               ONSITE AIR/HOTEL VACATION                

STATUS: HK  DEPARTURE: 21MAR          CONFO NO: 0475525820472757               

PRICE: BASE:          1305.45         OPTIONS :            108.00                

TOTAL: USD            1485.85                 USD              1485.85                

TAX1:            18.00             P. ADULT:             599.95                

TAX2:             0.00               P. CHILD:             285.95                

TAX3:            54.40                                                  

PENALTIES:             0.00                                                  

DPST:                 150.00 DUE 07MAR        BAL:                   1485.85 DUE 09MAR        

THANK YOU FOR CHOOSING A UNIVERSAL STUDIOS VACATION PACKAGE.

** PAYMENT DUE BY 7PM CST**. 

ENTER ADDITIONAL PNR INFORMATION IF REQUIRED/DESIRED AND END        

CONFIRM (EC) TO COMPLETE LEISURESHOPPER BOOKING                               

>   

CONSUMER ADVICE

RATES SHOWN INCLUDE HOTEL TAXES. PACKAGES AND RATES ARE SUBJECT
TO CHANGE WITHOUT NOTICE. RESTRICTIONS MAY APPLY. UNIVERSAL 
STUDDIOS VACATIONS PACKAGE PRICES ARE GUAR4ANTEED UPON FULL 
PAYMENT RECEIVED IN THE UNIVERSAL STUDIOS VACATIONS OFFICE.
ADVANCE PURCHASE REQUIREMENTS (14 DAYS OR MORE) MAY BE REQUIRED
TO SECURE PACKAGE RATES LISTED. MINIMUM 3 DAY ADVANCE PURCHASE
REQUIRED FOR ORLANDO AREA HOTELS. 1 DAY ADVANCE PURCHASE FOR 
ON-SITE HOTELS. UNIVERSAL STUDIOS VACATIONS RESERVES THE RIGHT TO
REINVOICE YOUR RESERVATION SHOULD AN ERROR ME MADE IN COMPUTING
YOUR PACKAGE PRICE. PACKAGE INCLUSIONS AND OPTIONS ARE SUBJECT TO
CHANGE WITHOUT NOTICE. 
LAST MINUTE BOOKINGS                                                                
BOOKINGS MADE WITHIN 45 DAYS OF DEPARTURE REQUIRE EITHER A
MONEY ORDER, CASHIER’S CHECK OR CREDIT CARD AS THE ONLY 
ACCEPTABLE FORM OF PAYMENT.

>LS*PD                                                                         
COMPLETE CONSUMER ADVICE                                                                          

PASSENGER NAME INFORMATION                                             -HELP           

>LSPN*                                                                         

NAME:*    .......................................................................................................           

PASSENGER:  1- 1                                                             

FREQ TRAVELER:  ..........................  ........................  ................................           

TITLE:  .................... AGE:     08       M/F:       .           SMOKE: Y/N:  .  

ISSUE CNTRY:  .. PASSPORT:  .................................................................        

PASSPORT EXP DATE:  ../../.. END               

PASSENGER:  1- 2                                                             

FREQ TRAVELER:  ........................  ..........................  .........................                  

TITLE:  ..................  AGE:      ..         M/F:    .             SMOKE: Y/N:  .                  

ISSUE CNTRY:  .. PASSPORT:  ....................................................................             

PASSPORT EXP DATE:  ../../.. END              

ENTER REQUIRED FIELDS                                                          

>   

• This screen will not appear if names have already been entered.  LSPN 
[passenger#] will display this screen if data needs to be verified or changed. 
For bookings with same last names: Under the LSPN prompt, on the 
Name line type the number in party lastname/firstname/firstname 
(e.g. [2THOMPSON/WILLIAM/BECKY]. Infant’s names are added in an
OSI entry. You will need to add W INF after the adult traveler name. 
For bookings with different last names: Under the LSPN prompt, on 
the Name line type the lastname/firstname of each guest, the names 
should be separated by an end-item and additional names with 
beginning with N: (e.g. [WILLIAMS/MARY†N:JOHNSON/TIM].
Note: Vacation will reprice with adult prices unless you fill in children
ages in all applicable fields. Tab to the END prompt to confirm.

11. Passenger Name Information

• After the LS*PD, prompt press ENTER to page down if necessary. 

• All advisory information on the chosen vacation will be on these screens.

• When you have read all screen press enter at the LSCA prompt.

12. Consumer Advice

• Enter received and phone fields. Then EC to confirm.

13. Additional PNR Information

• Confirmation number is returned along with pricing/deposit/
prepayment information.

14. Vendor Confirmation

7NW86R/AI QSBSB DQBAI           AG 52667252 07MAR                                      

1.3SMITH/JOHN/SUSAN/MARY                                            

1 LSS UNI 21MAR-24MAR HK3               ONSITE AIR/HOTEL VACATION              

PKGID-MCOUNZZZDLUA                  CF-0475525820472757                                

USD BAS 1305.45                 DEP-DUE07MAR 150.00 

OPT 108.00                    BAL-DUE09MAR 1485.85                                 

TAXES 72.40                      PEN 0.00                                             

TOTAL 1485.85                  COMM 141.35          *                               

*** LEISURESHOPPER     DATA EXISTS ***     >LSIT1                                   

FONE-ORDR/3125551234                                                          

>   

• To view commission, enter *R to display PNR.
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LeisureShopper Itinerary

Price

Form of Payment

Passenger Name Information

Consumer Advice

View Menu

Change

Cancel

Add Payment

Order Brochures

LSIT
LSPR
LSFP
LSPN
LSCA
LSVM
LSC
LSX

LSAP/
LSBR/

Return to current location in booking processs

LeisureShopper line number

Return to last primary screen

Page Down

Page Up

Search

Return to Package Select

Availability

Description of selection

Options Menu

Package Information (to view departure dates, commission information, terms & conditions, 
cancel change policies, features & options, special pricing properties featured)

TO ACCESS UNIVERSAL PARKS & RESORTS VACATIONS
LSS/V:UNI

HELP COMMANDS
Tab to the bottom of the command line and press enter to execute the commands

LS
LSN
LS*R
LS*PD
LS*PU
LSS

LSPS
LSA
LSD

LSOM

LSPI

AGENCY PAYMENT                 LEISURESHOPPER                   -HELP              

>LSAP*                                                                          CURR: USD                     

CREDIT CARD*: CA                                                              

CC NUMBER    *: 5555555555555555                            EXP DATE*: 1197   

CARD HOLDER : JOHN SMITH.................                                    

AMOUNT         *: 150.00..........                                      CURR    *: USD       

BILL ADDR        :                                     CTY :                                     

ST/PR    :                    ZIP :                        CNTRY :                           

PAYMENT ADVICE*: ...                                                          

DOC NUMBER   : ......................    PAY DATE  *:      04DEC                     

CLIENT FOP      : ...................       ISSUE CITY :       ...                       

AMOUNT          *: ................          CURR        *:       USD                       

• FOR EACH PAYMENT - MINIMUM REQUIRED IS ALL FIELDS WITH *.         

• Pull up PNR in Leisure Shopper, and tab to LSIT I prompt. 
Enter LSAP/ to view AGENCY PAYMENT screen. 

• To Add Payment by Agency Check, Miscellaneous Charge Order, or 
Credit Card: (1) Enter LSIT[segment #] from face of PNR to activate 
LeisureShopper itinerary (e.g. LSIT[ I]). (2) Enter LSAP/ to display 
the Agency Payment screen. (3) Complete fill-in format. For credit 
card: Complete top half of screen, entering the credit card code 
(BA=Visa, CA=MasterCard, DS= Discover, AX=American Express), card 
number, expiration date (MMYY), card holder's last name, and the 
amount (no $ sign) in the appropriate fields. For agency check: Complete
bottom half of screen, entering AGC in the Payment Advice field, check 
number in the Doc Number field, and the amount (no $ sign). For miscellaneous
charge order: Complete bottom half of screen entering MCO in the 
Payment Advice field, MCO number in the Doc Number field, and the 
amount (no $ sign). (4) Move cursor beyond last typed character and 
press enter. (5) Wait for response: Payment Accepted - EC to confirm. 
(6) Receive and EC to confirm addition of payment (e.g. R:P then EC). 
(7) If paying with a credit card, please retain a copy of the UCC for you records.

15. Agency Payment

QUICK REFERENCE CODES

The (   ) represents a SOM.

Brackets ([ ]) indicate what information type you should fill in.

Enter a pillow (   ) where this symbol appears in LeisureShopper for help in that item.

Use the TAB key to move the cursor to the appropriate prompt or field.

Use the LS*PD and LS*PU Prompts to page down or up for more information.

Enter LS to return to your current location in the booking process.

For product questions please contact our knowledgeable sales counselors at 1-800-823-4733
or email Help@universalorlando.com. For technical help contact Apollo directly at 1-770-280-8500.
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OSI MESSAGES:
• OSI messages are general informational messages that are added to confirmed bookings. They are hotel, and car requests. 

An OSI message should also be used to enter an infants full name. Do NOT use OSI message for handicapped passenger 
requests, seat requests or payment extensions.

• To add: (1) Display the confirmed booking (2) :30SIYY followed by the request or information and press ENTER 
(3) Enter Received field (4) Press ER to end and retrieve the PNR.

REVISING HOTEL: Penalties may apply check     LSPI for complete cancellation policies.
• Display Reservation.
• Enter LSIT[segment #] (e.g. LSIT[l]).
• Enter the line number of the hotel at the LSC prompt on the ITINERARY screen, (e.g. LSC[9]).
• Enter [line # of new hotel choice] at the LSNC prompt on the ACCOMMODATION Selection screen, (e.g. LSNC[7]).
• After the LSPR prompt, press enter on the ITINERARY screen to reprice the vacation.
• Enter after the LSFP prompt on the PRICING/PAYMENT screen.
• Enter LSCA.
• Enter Received field and EC (e.g. R:P[enter] then EC [enter]).
• Verify any transfers booked. 

ADDING TRANSFERS:
• Display Reservation.
• Enter LSIT[segment #] (e.g. LSIT[l]).
• Enter the line number of accommodation information at the LSVM prompt on the ITINERARY screen, they are identified by 

the letters ACC on the itinerary (e.g. LSVM [5]). A menu will display indicating what menus are available.
• Enter the number 16 for Option under accommodation level (e.g. LSV[ 16]), at the LSV prompt of the View Menu screen.
• Enter the number of the transfer option group selected, at the LSN prompt Continue by selecting the line number/quantity of transfers.
• At the LSN prompt enter zero to exit from the Options Menu and return to the Itinerary.
• After the LSPR prompt, press enter to reprice itinerary.
• Enter after LSFP on the PRICING/PAYMENT screen.
• Enter LSCA.
• Receive and EC to confirm the modification (e.g. R:P then EC).

TO ADD RENTAL CAR, INSURANCE, OR OPTIONAL TICKETS:
• Display Reservation.
• Enter LSIT [segment #] (e.g. LSIT(l]).
• At the LSVM prompt on the Itinerary screen, enter the line number of STOP information, identified by the letters STP on the 

itinerary (e.g. LSVM[3]). A menu will display indicating which menus are available at each level.
• At the LSV prompt of the View Menu screen, enter the number 13 for Option under STOP LEVEL (e.g. LSV[ 13]).
• Tab to the LSN prompt and enter the number of the option or option group. Add any additional options and quantity necessary.

If selecting Rental car remember to add pick-up or drop-off information.
• At the LSN prompt enter zero to exit from the Options Menu and return to the Itinerary.
• After the LSPR prompt, press enter to reprice itinerary.
• Enter after LSFP on the Pricing/Payment screen.
• Enter LSCA.
• Receive and EC to confirm the modification (e.g. R:P then EC).

TO CANCEL OPTIONS: Penalties may apply check LSPI for complete cancellation policies.
• Display Reservation.
• Enter LSIT[segment #] (e.g. LSIT[ I ]).
• Enter the line number of the item you want to cancel at the LSX prompt on the ITINERARY screen, (e.g. LSX[5]).
• Wait for response.
• After the LSPR prompt, press enter to reprice itinerary.
• Enter after LSFP on the Pricing/Payment screen.
• Enter LSCA.
• Receive and EC to confirm cancellation (e.g. R:P then EC). You may only cancel an optional item of a vacation. 

You cannot cancel any required item.

TO CANCEL ENTIRE RESERVATION: Penalties will apply check LSPI for complete cancellation policies. 
• Display Reservation.
• Enter LSIT[segment #] (e.g. LSIT[ I]).
• Enter the line number of the vacation at the LSX prompt on the Itinerary screen. (e.g. LSX[1]).
• Enter after the LSFP.
• Enter after the LSFP prompt on the Pricing/Payment screen.
• Receive and EC to confirm cancellation (e.g. R:P then EC).

ORDERING BROCHURES: (1) Enter LSBR/ (2) On the first line of the BROCHURE REQUEST screen, enter UNI as the vendor
code in front of the slash, and to the right of the slash fill in the destination(s) (Orlando or Los Angeles) for which you would like
brochures. (3) In the number of Brochures field Enter the quantity of brochures.(MAX 30) (4) To have the brochures sent to your
agency’s address, press enter after the last line of your agency’s address. (5) To have the brochure sent directly to your client type
a C in the Sent to Agency/Cust field and then type in the correct address of your client.


